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Chapter 1
Powering Up and Configuring Policy

Manager Hardware

This Getting Started Guide for the Dell Networking W-ClearPass Policy Manager System (Policy Manager)
describes the steps for installing the appliance using the Command Line Interface (CLI) and using the User
Interface (Ul) to ensure that the required services are running.

The back of the Policy Manager appliance contains three ports.

Figure 1: Policy Manager Backplane

o () o/ o @D o
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The ports illustrated in the figure above are described in the following table:

Table 1: Device Ports

Key Port Description

A Serial Initially configures the W-ClearPass Policy Manager appliance using a
hardwired terminal.

B - eth0 Management Provides access for cluster administration and appliance maintenance
(Gigabit using the WebUlI, CLI, or internal cluster communication. This
Ethernet) configuration is mandatory.

C - ethi Data (Gigabit Provides a point of contact for RADIUS, TACACS+, web authentication,
Ethernet) and other dataplane requests. This configuration is optional. If this port is
not configured, requests are redirected to the management port.

You can start the Initial Setup dialog when you connect a terminal, PC or workstation running a terminal
emulation program to the serial port on the W-ClearPass appliance

Before you Begin

Before starting the installation, determine the following information for your network, write it in the table
below, and keep it for your records:
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Table 2: Required Information

Requirement Value for Your Installation

Hostname (Policy
Manager server)

Management Port IP
Address

Management Port
Subnet Mask

Management Port

Gateway
Data Port IP Address NOTE: The Data Port IP Address must not be in the same subnet as the
(optional) Management Port IP Address.

Data Port Subnet Mask
(optional)

Data Port Gateway
(optional)

Primary DNS

Secondary DNS

NTP Server (optional)

Initial Setup Procedure
Perform the following steps to set up the Policy Manager appliance:

1. Connect and power on

Connect the serial port on the appliance to a terminal using the null modem cable provided, and power on
the appliance. The appliance is now available for configuration.

Use the following parameters for the serial port connection:
o Bit Rate: 9600
o DataBits: 8
o Parity: None
e Stop Bits: 1
e Flow Control: None
2. Login
Use the following preconfigured credentials to log in to the appliance. (You can create a unique
appliance/cluster administration password later.)
login: appadmin
password: eTIPS123
This initiates the Policy Manager Configuration Wizard.
3. Configure the Appliance
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Follow the prompts, replacing the placeholder entries in the following illustration with the information you
entered in Table 2:

Enter hostname: <hostname>

Enter Management Port IP Address: <management port IP>

Enter Management Port Subnet Mask: <management port subnet>

Enter Management Port Gateway: <management port gateway>

Enter Data Port IP Address: <data port IP>

Enter Data Port Subnet Mask: <data port subnet>

Enter Data Port Gateway: <data port gateway>

Enter Primary DNS: <primary DNS>

Enter Secondary DNS: <secondary DNS>

4. Change your password

Enter any string with a minimum of six characters. You are prompted to confirm the password. Once this
configuration is applied, you must use this new password for cluster administration and management of
the appliance.

5. Change the date and time

Follow the prompts to configure the system date and time. To set the date and time by configuring and NTP
server, use the primary and secondary NTP server information you entered in Table 2

6. Commit or restart the configuration

Follow the prompts to apply the configuration, restart the configuration procedure, or quit the setup
process.

When the Policy Manager system is up and running, navigate to the Administration > Agents and Software
Updates > Software Updates page to view and download any available software updates. Refer to in the
User Guide for more information.

To power off the system gracefully without logging in, access the command-line interface through a serial
connection to the front serial port, and enter the following commands.

login: poweroff
password: poweroff

This procedure gracefully shuts down the appliance.

To reset the administrator password in Policy Manager to factory defaults, you can login to the CLI as the
apprecovery user. The password to log in as the apprecovery user is dynamically generated.

Perform the following steps to generate the recovery password:

1. Connect to the Policy Manager appliance using the front serial port (using any terminal program). See Initial
Server Configuration on page 5 for details.

2. Reboot the system using the restart command.

3. Afterthe system reboots, the following prompt is displayed for ten seconds:
Generate support keys? [y/n]:

Entery at the prompt. The system prompts you with the following choices:

Please select a support key generation option.
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1) Generate password recovery key
2) Generate a support key

3) Generate password recovery and support keys

Enter the option or press any key to quit.

4. To generate a password recovery key, select option 1.

5. After the password recovery key is generated, email the key to Dell technical support. A unique password
will be generated from the recovery key and emailed back to you.

6. Enter the following command at the command prompt:

[apprecovery] app reset-passwd

khkhkhhkhkhhkhkhkhkh ok hhkhkhkhkhrkhkhhkhkhkhkhrhkhhkhkhkhkhrkhkhhkhkrkhkhkrhkhhkhkrkhxkx

* WARNING: This command will reset the system account *
* passwords to factory default values *
KA AR AA AR A AR A A AR A AR R A AR A AR A A AR A A kA A Ak Ak kA A Ak hkhArhkhk Aok kK x %
Are you sure you want to continue? [y/nl: y

INFO - Password changed on local node

INFO - System account passwords have been reset to factory default values

7. Now you can login with the new administrator password emailed to you by Dell technical support.

To troubleshoot certain critical system level errors, Dell technical support might need to log into a support shell.
Perform the following steps to generate a dynamic support password:

1. Loginto the CLI and enter the following command:
system gen-support-key

2. Connect to the Policy Manager appliance using the front serial port (using any terminal program). See Initial
Server Configuration on page 5 for details.

3. Reboot the system using the restart command.

4. When the system restarts, the following prompt appears for 10 seconds:
Generate support keys? [y/n]:
Entery at the prompt. The system prompts with the following choices:

Please select a support key generation option.

1) Generate password recovery key
2) Generate a support key
3) Generate password recovery and support keys

Enter the option or press any key to quit.

5. To generate the support key, select option 2. If you want to generate a support key and a password
recovery key, select option 3.

6. Afterthe password recovery key is generated, email the key to Dell technical support. A unique password
can now be generated by Dell technical support to log into the support shell.
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The CLI provides a way to manage and configure Policy Manager information. Refer to Appendix A: Command
Line Interface in the User Guide for more detailed information on the CLI.

The CLI can be accessed from the console using a serial port interface or remotely using SSH:

LR R R R e e e b b b i I S S S I b b b R e S S b S S b b b e S I S S S b b b e S S S S b b b b b e S S I b b b b b b I S S S S b b b b e S S S S b 2 i

* Dell W-ClearPass Policy Manager *

* Software Version : 6.4.0.62080 *
Ak hkkhkkhkhkhkhkhhhhkhkhkhhhh bk bk bk bk hkhkhhkhk bk bk bk bk hkhkhkhhkhkhk bk bk bk hkhkhkhkhkhkhkhk bk bk bk hkhkhhhhhkhkhkhkhkkhkhkhhkhkhkrrhkhkhkhkhkhkhkhkrhhkkkkkk

Logged in as group Local Administrator
[appadmin@company.com] #

The following subset of CLI commands may be useful at this point:

e To view the Policy Manager data and management port IP address, and DNS configuration:
show ip

e Toreconfigure DNS or add a new DNS:
configure dns <primary> [secondary] [tertiary]

e To reconfigure or add management and data ports:
configure ip <mgmt | data > <ipadd> netmask <netmask address> gateway <gateway address>

where:
Flag/Parameter Description
ip <mgmt| data> <ip o Network interface type: mgmt or data
address> e Server ip address.
netmask <netmask Netmask address.
address>
gateway <gateway Gateway address.
address>

o To configure the date (time and time zone optional):
configure date —-d <date> [-t <time>] [-z <timezone>]
e To configure the hostname to the node:
configure hostname <hostname>
o If you are using Active Directory to authenticate users, be sure to join the Policy Manager appliance to that
domain as well.

ad netjoin <domain-controller.domain-name> [domain NETBIOS name]

where:
Flag/Parameter Description
<domain-controller. Required.
domain-name> Host to be joined to the domain.

[domain NETBIOS name] | Optional.
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Chapter 2
Accessing Policy Manager

Use Firefox 3.0 (or higher) or Internet Explorer 7.0.5 (or higher) to perform the following steps:
1. Open the administrative interface.

Navigate to https://<hostname>/tips, where <hostname> is the hostname you configured during the initial
configuration.

Enter License Key.
3. Click the Activate Now link.

You have 28 day(s) to activate the product
&, Activate Now

Username:
Password:
User Type: @ Local © Network

4. Activate the product.

If the appliance is connected to the Internet, click on the Activate Now button. If not, click on the
Download button to download the Activation Request Token. Contact Dell Support and provide your
technician with the downloaded token in an email attachment. Once you receive the Activation Key from
Dell Support, save it to a known location on your computer. Come back to this screen and click on the
Browse button to select the Activation Key. Upload the key by clicking on the Upload button.

The product is now activated.

You have 87 day(s) to activate the product

Online Activation

Activate Now

Offline Activation

If you are not connected to the Internet, you can download an Activation Request
Token and obtain the Activation Key offline.

Step 1. Download an Activation Request Token

Email the Activation Request Token to Dell Support
(See dell.com/support)

Step 3. | Browse_

Upload the Activation Key received from Dell Support [UJGET]

Step 2.

Update License

Update License

5. Login. Username: admin, Password: eTIPS123
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ClearPass Po!

Usermame:[[ ]

Password:
Login
@ ClearPass Insight | %, ClearPass Guest | [ ClearPass Onboard

© Copyright 2013 Aruba Networks. Al rights reserved. ClearPass Policy Manager 6.1.0.47876 on CP-HW-5K platform

6. Change the password.

Navigate to Administration > Admin Users, then use the Edit Admin User popup to change the
administration password.

Admin Users

Filter:| User ID contains Show Al
# User ID & Name Privilege Level
1 admin Super Admin Super Administrator
ot
User ID: [admir] |
MName: Super Admin
Password: sessssee
Verify Password: ssssense
Privilege Level Super Administrator o

The Policy Manager User Guide (in PDF format) is built within the help system here:
https://<hostname>/tipshelp/html/en/

(where <hostname> is the hostname you configured during the initial configuration.)

All Policy Manager user interface screens have context-sensitive help. To access context-sensitive help, click on
the Help link at the top right hand corner of any screen.
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Chapter 3
Checking Basic Services

To check the status of service, navigate to Administration > Server Manager > Server Configuration,
then click on a row to select a server:

e The System tab displays server identity and connection parameters.

e The Service Control tab displays all services and their current status. If a service is stopped, you can use its
Start/Stop button (toggle) to restart it.

System Services Control Service Parameters System Monitoring Network FIPS

Service Name Status Action
1. AirGroup notification service Running m
2. Async DB write service Running m
3. Async network services Running m
4. DB change notification server Running m
5. DB replication service Running m
6. Micros Fidelio FIAS Running m
7. Multi-master cache Running m
8. Policy server Running m
9. Radius server Running m
10.  System auxiliary services Running m
11.  System monitor service Running m
12. Tacacs server Running m
13.  Virtual IP service Stopped m
14.  AMG-AD Domain service Running m
<. Back to Server Configuration

You can also start an individual service from the command line,

service start <service-name>

or all services from the command line,

service start all
o The Service Parameters tab allows you to change system parameters for all services.

e The System Monitoring tab allows you to configure SNMP parameters, ensuring that external
MIB browsers can browse the system-level MIB objects exposed by the Policy Manager appliance.

e The Network tab allows you to view and create GRE tunnels and VLANS.

e The FIPS tab is used to enable W-ClearPass in Federal Information Processing Standard mode. For most
users, this tab should be ignored. Changing the mode to FIPS mode causes the database to be reset.
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Appendix A
Use Cases

This appendix contains several specific W-ClearPass Policy Manager use cases. Each one explains what it is
typically used for, and then describes how to configure Policy Manager for that use case.

e 802.1X Wireless Use Case on page 15

e Web Based Authentication Use Case on page 21

e MAC Authentication Use Case on page 28

e TACACS+ Use Case on page 31

e Single Port Use Case on page 32

The basic Policy Manager Use Case configures a Policy Manager Service to identify and evaluate an 802.1X
request from a user logging into a Wireless Access Device. The following image illustrates the flow of control for
this service:

Figure 2: Flow of Control, Basic 802.1X Configuration Use Case

Service
Swilch sends 802.1X
regquest: Polic SERVICE:
2quest; Folicy B02.1X Wireless
Manager evaluates . .
and returns Policy Manager categorizes Authentication
connection control request b}r Service T},ﬂpg Method
attributes
AUTHENTICATION METHOD:
f 4 methods specified, illustrating
principle of list from which methods
- - tested by Policy M in ord
Authentication e Y oty oo
Source i Initiate authentication
based on specified method
AUTHENTICATION SOURCE:

2 sources specified; Policy Manager
authenticates requests against the
sources in arder of priority.

l Role Mapping

Validate client identify against
the specified source
ROLE MAPPING (using atiributes

from AUTHORIZATION SOURCES):
RMP_DEPARTMENT

Posture (client:department mapping)
Evaluation Map client identity to role
POSTURE SERVER:
P8 NPS
Enforcement
Evaluate posture; return Poli

“posture foken"” representing olicy
health

ENFORCEMENT POLICY:

Role_Based Allow_Access Policy

L J

inf?.;cement Based on posture token, role,
rotile and system time, map client

to an Enforcement Profile
ENFORCEMENT PROFILES:
AllowAcoess
DenyAccass

>
<}

Return connection attributes
(representing assigned
access) to the switch
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Policy Manager ships with fourteen preconfigured services. In this use case, you select a service that supports
802.1X wireless requests. Follow the steps below to configure this basic 802.1X service that uses [EAP FAST],
one of the pre-configured Policy Manager authentication methods, and Active Directory Authentication
Source (AD), an external authentication source within your existing enterprise.

NOTE

HNOTE

Policy Manager fetches attributes used for role mapping from the authorization sources (that are associated with the
authentication source). In this example, the authentication and authorization source are one and the same.

Policy Manager tests client identity against role-mapping rules, appending any match (multiple roles
acceptable) to the request for use by the enforcement policy. In the event of role-mapping failure, Policy
Manager assigns a default role. This use case create the role mapping policy RMP_DEPARTMENT that
distinguishes clients by department and the corresponding roles ROLE_ENGINEERING and ROLE_FINANCE, to
which it maps.

Policy Manager can be configured for a third-party posture server, to evaluate client health based on vendor-
specific credentials, typically credentials that cannot be evaluated internally by Policy Manager (that is, not in
the form of internal posture policies). Currently, Policy Manager supports the following posture server
interface: Microsoft NPS (RADIUS).

For purposes of posture evaluation, you can configure a posture policy (internal to Policy Manager), a posture server
(external), or an audit server (internal or external). Each of the first three use cases demonstrates one of these
options; here, the posture server.

Configuring a Service

1. Navigate to Configuration > Services.

2. Click the =® add iconto add a service. The Configuration > Services > Add window opens.
3. Ifitis not already selected, click the Service tab and define basic service information.

a. Enter aname for the service in the Name field.

b. Click the Type drop-down list and select 802.1X Wireless.

¢. (Optional) click the Monitor Mode checkbox to allow handshakes to occur (for monitoring purposes), but
without enforcement.

d. Click Next to display the Authentication tab.
4. Configure authentication.
a. Inthe Authentication Methods field, select [EAP Fast].

b. Inthe Authentication Sources field, click the Select to Add drop-down list and select the following
sources.

[Local User Repository] [Local SQL DB]
[Guest User Repository] [Local SQL DB]
[Guest Device Repository] [Local SQL DB]
[Endpoints Repository] [Local SQL DB]
[Onboard Devices Repository] [Local SQL DB]
[Admin User Repository] [Local SQL DB]
[Active Directory]

c. (Optional) Select Strip Username Rules to pre-process the user name (to remove prefixes and
suffixes) before sending it to the authentication source.
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Creating a New Role Mapping Policy

To create a new Role Mapping policy:

1. Click the Roles tab.

2. Click Add new Role Mapping Policy. The Role Mappings page opens.

Figure 3: Role Mapping Navigation and Settings

Service Authentication Authorization m Posture Enforcement Audit Profiler Summary

Role Mapping Policy: —Select- |Z| Modify Add new Role Mapping Policy

Role Mapping Policy Details

Description:
Default Role:

Rules Evaluation Algorithm: -

Conditions Role

3. Add a new role, navigate to the Policy tab. Enter the Policy Name, For example, ROLE_ENGINEER and click

Save. Repeat the same step for ROLE_FINANCE. The following figure displays the Policy tab:

Figure 4: Policy Tab

Configuration » Identity » Role Mappings » Add

Role Mappings

Mapping Rules Summary

Policy Name: |RMP_DEPARTMENT
Description:
Default Role: [Guest] D Add new Role

Add New Role

€ Bac

[ROLE_FINANCE

Add New Role

Name: [ROLE_ENGINEER]

Description:

[sove | carce |

4. Click the Next button in the Rules Editor.

5. Create rules to map client identity to a role. From the Mapping Rules tab, select the Rules Evaluation

Algorithm radio button. The following figure displays the Mapping Rules tab:
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Figure 5: Mapping Rules Tab

Configuration » Identity » Role Mappings » Add

Role Mappings

Policy Mapping Rules Summary

Rules Evaluation Algorithm: O Select first match & Select all matches

Role Mapping Rules:

Conditions Role Name
1.|(Authorization:AD:department CONTAINS engineer) Role_Engineer
2.|(Authorization:AD:department CONTAINS finance) ROLE_FINANCE

Move Up | Move Down | Edit Rule | Remove Rule |

Rules Editor o

Matches & ANY or O ALL of the following conditions:
Type Name Operator Value
1.|Authorizati0n:AD department CONTAINS finance i
2. Click to add...
Role Name: [Contractor] |Z|

Employee] Save

R [ save J Cancel |
Other]

TACACS API Admin]

TACACS Network Admin]
TACACS Read-only Admin]
TACACS Receptionist]
TACACS Super Admin]

[
[
%
[TACACS Help Desk]
[
[
[
[

< Back to Role Mappings m

6. Select the Select all matches radio button.

Upon completion of each rule, click the Save button in the Rules Editor.
8. Click the Save button.

Match the conditions with the role name. Click the Add Rule button. The Rules Editor pop-up opens.

Add the new role mapping policy to the service from the Roles tab. The following figure displays the Roles

tab:

Figure 6: Roles Tab

Service Authentication Authorization m Posture Audit Enforcement Summary

Role Mapping Policy: ‘RMP DEPARTMENT = Add new Role Mapping Policy
Role Mapping Policy Details
Description: -
Default Role: [Guest]

Rules Evaluation Algorithm: evaluate-all

Conditions Role
1. (Authorization:AD:department CONTAINS engineer) Role_Engineer
2. (Authorization:AD:department CONTAINS finance) ROLE_FINANCE

18 | Use Cases
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10.Select Role Mapping Policy, for example, RMP_DEPARTMENT. Click Next.

11.Add an Micrsoft NPS external posture serverto the 802.1X service. Click the Posture tab. The following
figure displays the Posture tab:

Figure 7: Posture Tab

Service Authentication Authorization Roles Enforcement Audit Profiler Summary
Posture Policies:
Posture Policies: - Remaove
- Modify
~Select to Add— [=]
Default Posture Token: UNKNOWN (100)
Remediate End-Hosts: Enable auto-remediation of non-compliant end-hosts
Remediation URL:
Posture Servers:
Posture Servers: - Remove
- Modify
~Select to Add— [=]
<. Back to Services

12.Click Add new Posture Server to add a new posture server.
13.Configure the following posture settings examples:

o Name (freeform). PS_NPS

o Server Type radio button: Microsoft NPS

o Default Posture Token (selector): UNKOWN

The following figure displays the Posture Server tab:

Figure 8: Posture Server Tab

Primary Server Backup Server Summary

Name:

Description:

Server Type: @ Microsoft NPS
Default Posture Token: UNKNOWN (100) |Z|

14.Click Next.

15.Configure connection settings in the Primary/ Backup Server tabs by entering the connection
information for the RADIUS posture server. The following figure displays the Primary Server tab:
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Figure 9: Primary Server Tab

Posture Server

Backup Server Summary

RADIUS Server Name:

RADIUS Server Port: (default is 1812)

Shared Secret: Verify:

Timeout: 5 seconds

< Back to Services

[ext> ] Sov | conc |

16.Click Next from primary server to backup server. Click Save.

17.Add the new posture server to the service. From the Posture tab, enter the Posture Servers, for example,
PS_NPS, then click the Add button. The following figure displays the Posture tab:

Figure 10: Posture Tab

Service Authentication Authorization Roles Enforcement Audit Profiler Summary
Posture Policies:
Posture Policies: Tt Add new Posture Policy
View Details
Modify
~Select- [~
Default Posture Token: UNKNOWN (100) D
Remediate End-Hosts: [ enable auto-remediation of non-compliant end-hosts
Remediation URL:
Posture Servers:
Posture Servers: PS_NPS [RADIUS] Remave Add new Posture Server
View Details
-Select- Dw

18.Click the Next button. Assign an enforcement policy.

19.Enforcement policies contain dictionary-based rules for evaluation of Role, Posture Tokens, and System

Time to evaluation profiles. Policy Manager applies all matching enforcement profiles to the request. In the

case of no match, Policy Manager assigns a default enforcement profile. The following figure displays the
Enforcement tab:

Table 3: Enforcement Policy Navigation and Settings

Service Authentication Roles Posture Audit Profiler Summary

Use Cached Results:

[C] use cached Roles and Posture attributes from previous sessions

[Sample Allow Access Policy] |Z|

Enforcement Policy Details

Enforcement Policy:

Add new Enforcement Policy

Description: Sample policy to allow network access
Default Profile: [allow Access Profile]

Rules Evaluation Algorithm: evaluate-all

Conditions

Enforcement Profiles
(Date:Day-of-Week BELONGS_TO Monday, Tuesday, Wednesday, Thursday, Friday, Saturday,
Sunday)

[Allow Access Profile]

< Back to Services
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20. From the Enforcement tab, select the Enforcement Policy, for example, Role_Based_Allow_Access_
Policy. For instructions about how to build such an enforcement policy, refer to "Configuring Enforcement
Policies" in the W-ClearPass Policy Manager User Guide.

21.Save the service.

This Service supports known Guests with inadequate 802.1X supplicants or posture agents. The following
figure illustrates the overall flow of control for this Policy Manager Service.

Figure 11: Flow-of-Control of Web-Based Authentication for Guests

_ Service
Reguest from a dlient
without adequate posture
agent or supplicant
SERVICE:
Client is redirected to Dell Weah Based Authentication

Web Porial to capture i
username’password and
evaluate posture, Policy Manager categorizes
request by Service Type
Policy Manager processes q y yp
request; returns access

\_control attributes to switch. / NO AUTHENTICATION METHOD:
ry Paolicy Manager intemal method
authenticates captured Dall Web
Portal login

Authentication

Source AUTHENTICATION SOURCE:
Local_User Repostiory

Validate client identity against l R .
ole Mapping

the specified source

ROLE MAPPING (using attributes
from AUTHORIZATION SOURCE or
using built-in Guest role)

PDStE‘"e POSTURE POLICY: Map client identity to role
Evaluation IPP_UNIVERSAL
Evaluate posture; return Enforcement
“"posture token” representing Poli
health olicy
ENFORCEMENT POLICY:
SNMP_POLICY
»> Based on posture foken,
Enforcement ENFORCEMENT POLICY: rolea, and system time, map
Profile Guest Limited ’ client to an Enforcement

Guest_Full Profile

Return connection attributes
(representing assigned
access) to the switch

F

Configuring a Service
Perform the following steps to configure Policy Manager for WebAuth-based Guest access.

1. Prepare the switch to pre-process WebAuth requests for the Policy Manager Dell WebAuth service.

Refer to your Network Access Device documentation to configure the switch such that it redirects HTTP
requests to the Dell Guest Portal, which captures username and password and optionally launches an agent
that returns posture data.

2. Create a WebAuth-based Service.
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Table 4: Service Navigation and Settings

Navigation Settings

Create a new Service:

Corfigurason » Serves

Services

o 4dd

e Type (selector):
Dell Web-Based
Authentication >

Name/Descriptio
n (freeform) >

e Upon completion,
click Next.

e Services > Limpot

. & bt
e Add Service >
Name the Service and Configuration » Services » Add
select a pre- Services
Conﬁgured Service m Authentication Authorization Roles Posture Enforcement Summary
Type: Type: Web-based Authentication El
e Service (tab) > Name:

Description: Web Based Authentication for Guests

Monitor Mode:

More Options:

[ZJ Enable to monitor network access without enforcement

Authorization Posture Compliance

Service Rule
Matches ) ANY or @ ALL of the following conditions:

Type Name Operator Value b
1.|H05t CheckType MATCHES_ANY Authentication L]
2.click to add...

<. Back toServices

3. Set up the Authentication.

a. Method: The Policy Manager WebAuth service authenticates WebAuth clients internally.

b. Source: Administrators typically configure Guest Users in the local Policy Manager database.

4. Configure a Posture Policy.

(external), or an Audit Server (internal or external). Each of the first three use cases demonstrates one of these

E For purposes of posture evaluation, you can configure a Posture Policy (internal to Policy Manager), a Posture Server

NOTE options. This use case demonstrates the Posture Policy.

As of the current version, Policy Manager ships with five pre-configured posture plugins that evaluate the
health of the client and return a corresponding posture token.

To add the internal posture policy /PP_UNIVERSAL_XP, which (as you will configure it in this Use Case, checks
any Windows® XP clients to verify the most current Service Pack).
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Table 5: Local Policy Manager Database Navigation and Settings

Navigation Settings

Select the local Policy

Manager database:

e Authentication (tab) >

e Sources (Select drop-down
list): [Local User
Repository] >

e Add>

e Strip Username Rules

Authentication Sources:

Strip Username Rules:

“ Back to Services

Service Authentication Authorization Roles Posture Enforcement Summary

Local User Repository] [Local SQL DB - — Add new Authentication Source
Move Up

Move Down
View Details

Modify

—Selectto Add—

Enable to specify a comma-separated list of rules to strip username prefixes or suffixes
[user/ ]
If username precedes domain name, Use USer: <separators (e.g., user:@)
Otherwise, use <separator>:user (e.g., \:user)

Next> §| Save J Cancel

(check box) >

e Enter an example of
preceding or following
separators (if any), with the
phrase “user” representing
the username to be
returned. For
authentication, Policy
Manager strips the
specified separators and
any paths or domains
beyond them.

e Upon completion, click
Next (until you reach
Enforcement Policy).
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Table 6: Posture Policy Navigation and Settings

Navigation Setting

Create a Service Authentication Authorization Roles m Enforcement Summary
Posture Policy: .
Posture Policies:
® POSture Posture Policies: B Remove Add new Posture Policy
(ta b) > View Details
o Enable éimf’
. . —Selectto Add-
Validation - .
Default Posture Token: UNKNOWM (100)
Check —
(Check bOX) N Remed?at.e End-Hosts: Enable auto-remediation of non-compliant end-hosts
Remediation URL:
Posture Servers:
e Add new Posture Servers: - e Add new Posture Serve
Internal View Details
Policy (link) M
~Selectto Add— [=]
>
“ Back to Services m
Na me the Configuration » Posture » Posture Policies » Add
Posture Policy Posture Policies
and specify a
Posture Plugins Rules Summary
general class of
ope rating Policy Name: IPP_UNIVERSAL
. Description: Policy to check health of Windows XP
SyStem. endpoints
° POIlcy (ta b) Posture Agent: ) MAP Agent (& OnGuard Agent (Persistent or Dissolvable)
> Host Operating System: ® windows O Linux Mac 0S X
e Policy
Name
(freeform):
IPP_ )
UNIVERSAL > 4. Back to Services
o Host
Operating
System
(radio
buttons):
Windows >
e When
finished
working in
the Policy
tab, click
Next to
open the
Posture
Plugins tab
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Table 6: Posture Policy Navigation and Settings (Continued)

Navigation Setting

Selecta

Validator:

e Posture
Plugins (tab)
>

e Enable
Windows
Health
System
Validator >

e Configure
(button) >

Summary

Policy Posture Plugins Rules

Select one/more plugins:
Plugin Name Plugin Configuration

& ‘ ClearPass Windows Universal System Health Validator Configure _| View

Status

‘ Windows System Health Validator

0 ‘ Windows Security Health Validator Configure | View

Not Configured

« Back to Services

Configure the

Validator:

e Windows
System
Health
Validator
(popup) >

e Enable all
Windows
operating
systems
(check box) >

e Enable
Service Pack
levels for
Windows 7,
Windows
Vista®,
Windows XP
Windows
Server®
2008,
Windows
Server 2008
R2, and
Windows
Server 2003
(check
boxes) >

e Save
(button) >

Windows System Health Validator L

Client computers can connect to your network, subject to the following checks -

Windows 7
Windows 7 clients are allowed
[0 Restrict clients which have Service Pack less than

Windows Vista

Wwindows Vista clients are allowed
[0 Rrestrict clients which have Service Pack less than

Windows XP
Wwindows XP clients are allowed
[T Restrict clients which have Service Pack less than

Windows Server 2008

Windows Server 2008 clients are allowed
[Tl Restrict clients which have Service Pack less than

Windows Server 2008 R2

Windows Server 2008 R2 clients are allowed
O Restrict clients which have Service Pack less than

Windows Server 2003
Windows Server 2003 clients are allowed

Reset

m
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Table 6: Posture Policy Navigation and Settings (Continued)

Navigation Setting

e When
finished
working in
the Posture
Plugin tab
click Next to
move to the
Rules tab)

Set rUIeS to Policy Posture Plugins m Summary
correlate Rules Evaluation Algorithm: First applicable
Va|ldat|0n Conditions Posture Token

; Passes all SHV checks -
rESUIts Wlth *| Windows System Health Validator

. Fails one or more SHV checks -

pOSture tOke ns: 2" Windows System Health Validator UAR T
¢ Rules (ta b) > Moveup |  mMoveDown | EditRue | RemoveRue |

Rules Editor e

HEALTHY

e Add Rule

(buttOn Select Plugin Checks: Passes all SHV checks [~]

Select Plugins: [ windows System Health validater

opens
opup) >
p p p) . Posture Token: HEALTHY (0) D ‘
e Rules Editor
[sovo ] conc

(popup) >
« Back to Services m m

e Conditions/
Actions:
match
Conditions
(Select
Plugin/
Select Plugin
checks) to
Actions
(Posture
Token)>

e Inthe Rules
Editor, upon
completion
of each rule,
click the
Save button
>

e When
finished
working in
the Rules
tab, click the
Next button.
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Table 6: Posture Policy Navigation and Settings (Continued)

Navigation Setting

Remediate End-Hosts:

(selector): IPP_
UNIVERSAL_XP,
then click the
Add button

Remediation URL:

Posture Servers:

Posture Servers:

—Select-

4. Back to Services

[ Enable auto-remediation of non-compliant end-hosts

Remove
View Details
Modify

[=] Add

Add the new Service Authentication Authorization Roles Enforcement Summary
Posture Policy to .
. Posture Policies:
the SerVICe: Posture Policies: Add new Posture Policy
Back in Posture
(tab) > E—._____ p—
~Select- Add
Internal - .
. . Default Posture Token: UNKNOWN (100
Policies = =]

Add new Posture Server

The following fields deserve special mention:

[ |
[ |
for remediation.
= Remediation URL. URL of remediation server.

Create an Enforcement Policy.

Because this Use Case assumes the Guest role, and the Dell Web Portal agent has returned a posture token,

it does not require configuration of Role Mapping or Posture Evaluation.

Default Posture Token. Value of the posture token to use if health status is not available.
Remediate End-Hosts. When a client does not pass posture evaluation, redirect to the indicated server

limited guest access.

The SNMP_POLICY selected in this step provides full guest access to a Role of [Guest] with a Posture of Healthy, and

Table 7: Enforcement Policy Navigation and Settings

Navigation Setting

Default Profile: Restricted SNMP VLAN

Policy (selector):
SNMP_POLICY

Rules Evaluation Algorithm:  evaluate-all

Conditions

Enforcement Profiles

Add a new Service Authentication Authorization Roles Posture Summary
Enforcement PO“Cy: Use Cached Results: Use cached Roles and Posture attributes from previous sessions
° Enforcement Enforcement Policy: SNMP Palicy Add new Enforcement Policy
(ta b) > Enforcement Policy Details
Description:
e Enforcement

(Tips:Role EQUALS Guest)
e Upon " AND (Tips:Posture EQUALS HEALTHY (0)) Restricted SNMP VLAN
completion, click
Save. 4, Back to Services

6. Save the Service.

Click Save. The Service now appears at the bottom of the Services list.

Dell Networking W-ClearPass Policy Manager | Getting Started Guide

Use Cases | 27



This Service supports Network Devices, such as printers or handhelds. The following image illustrates the overall
flow of control for this Policy Manager Service. In this service, an audit is initiated on receiving the first MAC
Authentication request. A subsequent MAC Authentication request (forcefully triggered after the audit, or
triggered after a short session timeout) uses the cached results from the audit to determine posture and role(s)
for the device.

Figure 12: Flow-of-Control of MAC Authentication for Network Devices

Note regarding color coding: This service (optionally) gathers information via Audit Server an the first pass, then re-
authenticates the client after a short session timeout; on the second pass, it re-authenticates, allowing Policy Manager to
use Role and Posture information from cache to perform Enforcement

Service
Authentication

SERVICE: Method
Switch falls back to MAC 1— Mac Auth Bypass
authentication reguest (on
B02.1X failure) to Palicy Policy Manager cafegorizes 1
Managar wilh MAC address request by Service Type —.2'_}
el T AUTHENTICATION METHOD:

MACAuth
A A
1 Initiate authentication

based on specified method

Authentication
Source ,l,

AUTHENTICATION SOURCE: Role Mapping
For MAC Bypass, one oplion is a
Static Hosts List (SHL), or can be
any other supported i
authentication source s ROLE MAPPING (optional):

»>
: ) . . . praannnanny Role information found in cache on
Validate client identity against 2 second pass: on first pass, Role Mapping

the specified source Feeeeeh optional [otherwise, skip to audit server)

1
l Audit Server

I I
S

POSTURE:
Posture information found in cache on
second pass, if audit performed by
MESSIUS server; on first pass, skip to

ALUDIT SERVER {optianal):
i Messus or NMAP audit with post-audit
. rules; cache the results,
On sacand pass, after Authentication,

Audit Sarver. skip to Enforcament.
Test Posture; Evaluate Role
2 l
Enforcement
ENFORCEMENT POLICY:
Profile Role_Based_Access_Policy
ENFORCEMENT PROFILE: Based on posture token, o |
VLAN_ENFORCEMENT_QUARANTINE roles, and system time, map
VLAN_ENFORCEMENT_FULL_ACCESS 5 C”Enf to an Eﬂfﬂi’CEﬂiEﬂf
Return connection attributes Profile
(representing assigned
access) to the switch Enforcement
Policy

Configuring the Service
Follow these steps to configure Policy Manager for MAC-based Network Device access.

1. Create a MAC Authentication Service.
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Table 8: MAC Authentication Service Navigation and Settings

Navigation Settings

Create a new Service: asn Svces
Services ;fﬂd .
e Services > 2 Eport Al
o Add Service (link) >
Name the Service and selecta | |configuration » sarvices » Add
) . Servi
pre-configured Service Type: Srvices
e Service (tab) > Authentication | Authorization | Roles | Enforcement | Audit  Profiler | Summary
° Type (selector): MAC Type: MAC Authentication [~]
. . Name:
AUthentl catlon > Description: MAC-based Authentication service
e Name/Description
(freeform) > Monitor Mode: [ Enable to monitor network access without enforcement
. . More Options: Authorization Audit End-hosts Profile Endpaints
e Upon completion, click Sarvice fulo
Next to Conﬁgure Matches & ANY or @ ALL of the following conditions:
R X Type Name Operator Value i
Authentication .|Radius: IETF NAS-Port-Type BELONGS_TO Ssgé;r'la(tl(gl)s)' Jeeies @
2.|Radius: IETF Service-Type EQUALS call-Check (10) @
3.|Connection Client-Mac-Address EQUALS %s{Radius:IETF:User-Name} By
4.|Click to add
<« Back to Services

2. Set up Authentication.

You can select any type of authentication/authorization source for a MAC Authentication service. Only a
Static Host list of type MAC Address List or MAC Address Regular Expression shows up in the list of
authentication sources (of type Static Host List). For more information on static host list, see "Adding and
Modifying Static Host Lists" in the W-ClearPass Policy Manager User Guide. You can also select any other

supported type of authentication source.

Table 9: Authentication Method Navigation and Settings

Navigation Settings

Select an Authentication Method and

two authentication sources - one of

type Static Host List and the other of

type Generic LDAP server (that you

have already configured in Policy

Manager):

e Authentication (tab) >

e Methods (This method is
automatically selected for this
type of service): [MAC AUTH] >

Strip Username Rules:

“. Back to Services

Service Authentication Authorization

Authentication Methods:

Authentication Sources:

Roles Enforcement Audit Profiler Summary

[MAC-AUTH] Add new Authentication Method

Move Up

View Details
Modify

[¥] Add

Add new Authentication Source
Move Up
Move Down

Remove

View Details
Modify

[<]l§ Add

[ Enable to specify a comma-separated list of rules to strip username prefixes or suffixes

—Select-

Handhelds [Static Host Lis{

—Select-

e Add>
Sources (Select drop-down list):
Handhelds [Static Host List] and
Policy Manager Clients White List
[Generic LDAP] >

e Add>

e Upon completion, Next (to Audit)

3. Configure an Audit Server.
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This step is optional if no Role Mapping Policy is provided, or if you want to establish health or roles using an
audit. An audit server determines health by performing a detailed system and health vulnerability analysis
(NESSUS). You can also configure the audit server (NMAP or NESSUS) with post-audit rules that enable
Policy Manager to determine client identity.

Table 10: Audit Server Navigation and Settings

Navigation Settings

Configure the Audit Server: entorcement Q] erorier

e Audit (tab) > B viewrvetai | wioair, |

e Audit End Hosts (enable) >

e Audit Server (selector):
NMAP

e Trigger Conditions (radio
button): For MAC
authentication requests

o Reauthenticate client (check
box): Enable

Service Authentication Authorization Roles Summary

Audit Server: [Nmap Audil Add new Audit Server

Audit Trigger Conditions: O Always

O When posture is not available

@ For MAC authentication request
© For known end-hosts only
© For unknown end-hosts only
@ For all end-hosts

© No Action
© Do SNMP bounce
© Trigger RADIUS CoA action

Action after audit:

“. Back to Services

Upon completion of the audit, Policy Manager caches Role (NMAP and NESSUS) and Posture (NESSUS), then
resets the connection (or the switch reauthenticates after a short session timeout), triggering a new request,
which follows the same path until it reaches Role Mapping/Posture/Audit; this appends cached information
for this client to the request for passing to Enforcement. Select an Enforcement Policy.

4. Select the Enforcement Policy Sample_Allow_Access_Policy:

Table 11: Enforcement Policy Navigation and Settings

Navigation Setting

¥i Use cached Roles and Posture attributes from previous sessions

Enforcement Policy Details

Description:

Service Authentication Authorization Profiler Summary

Select the Enforcement Policy:

e Enforcement (tab) >

e Use Cached Results (check
box): Select Use cached Roles
and Posture attributes from

previous sessions >

Use Cached Results:

Enforcement Policy: UnmangedClientPolicy Add new Enforcement Policy

Enforcement Policy for Unmanaged Clients
Default Profile: [Deny Access Profile]

Rules Evaluation Algorithm: first-applicable

Conditions Enforcement Profiles

e Enforcement Policy
(selector):
UnmanagedClientPolicy

e Whenyou are finished with

(Tips:Role EQUALS Printers)
(Tips:Role EQUALS IP Phones)
(Tips:Role EQUALS Handhelds)
(Tips:Role EQUALS Role_Engineer)
(Tips:Role EQUALS eTIPS_Guest)
(Tips:Role EQUALS Unknown Client)

N

WIRELESS_EMPLOYEE_NETWORK
WIRELESS_EMPLOYEE_NETWORK
WIRELESS_GUEST_NETWORK
WIRELESS_EMPLOYEE_NETWORK
WIRELESS_GUEST_NETWORK
WIRELESS_CAPTIVE_NETWORK

your work in this tab, click
Save.

., Back to Services

o> ] 5o | carc |

Unlike the 802.1X Service, which uses the same Enforcement Policy (but uses an explicit Role Mapping
Policy to assess Role), in this use case Policy Manager applies post-audit rules against attributes captured by
the Audit Server to infer Role(s).

u

Save the Service.
Click Save. The Service now appears at the bottom of the Services list.
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This Service supports Administrator connections to Network Access Devices via TACACS+. The following image
illustrates the overall flow of control for this Policy Manager Service.

Figure 13: Administrator connections to Network Access Devices via TACACS+

Service

SERVICE:
[Admin Metwork Login Senvice)]

Switch sends TACACS+ : :
request, Policy Manager categorizes
request by Service Type NO AUTHENTICATION METHOD:
For TACACS, authentication method

is internal 1o the Service.

Authentication

Source
AUTHENTICATION SOURCE: Role Mapping
For TACACS+, oplion to use
Active Direciony
Validate client identity against ROLE MAPPING (optianal .
the specified source Using atiributes from
AUTHORIZATION SOURCE.
Map client identity to role
NO POSTURE:
1 TACACS+ Icgin ti'rt‘hendfd té:raythantit.aie NO AUDIT SERVER:
user Identlly, not a device. TACACS+ login intended to authenticate
user identity, not a device.
Enforcement Enf t
Profile niorcemen
Policy
ENFORCEMENT PROFILE:
[TAGACS HelpDesk] ENFORCEMENT POLICY:
O [Admin Network Login Paolicy]

[TACACS Netwark Admin]
[TACACE Receptionist]

TACACS Super Admin] Based on posture token, role,

and system time, map client
Return connection atiributes D — to an Enforcement Profile
(representing assigned
access) to the switch

Configuring the Service
Perform the following steps to configure Policy Manager for TACACS+-based access:

1. Navigate to Configuration > Services.

2. Clickthe % add icon to add a service. The Configuration > Services > Add window opens.
3. Ifitis not already selected, click the Service tab and define basic service information.
a. Enter a name for the service in the Name field.

b. Click the Type drop-down list and select the preconfigured service type that matches your Policy
Manager Admin Network Login Service.

c. Click Next to display the Authentication tab.
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4. Define the Authentication settings for the service. Authentication methods can be left to their default
values, as the Policy Manager TACACS+ service authenticates TACACS+ requests internally.

a. Inthe Authentication Sources section, click the Select to Add drop-down list.

b. Select AD (Active Directory). For this use case example, Network Access Device authentication data
will be stored in the Active Directory.

5. Click the Enforcement tab and select an Enforcement Policy.

a. Click the Enforcement Policy drop-down list and select the Enforcement Policy [Admin Network Login
Policy] that distinguishes the two allowed roles (Net Admin Limited and Device SuperAdmin).

6. Click Save. The Service now appears at the bottom of the Services list.

This Service supports all three types of connections on a single port.

The following figure illustrates both the overall flow of control for this hybrid service, in which complementary
switch and Policy Manager configurations allow all three types of connections on a single port:

Figure 14: Flow of the Multiple Protocol Per Port Case

Switch
Yes: Switch sends request
ftch port to Policy Manager as 802.1X/
y EAP; Policy Manager
processes using 802, 7X
Service

No: Switch sends request to Policy Manager as MAC Bypass,

Policy Manager attempts to process using MAC Authentication
Service

Policy
Manager

Yes: Palicy Manager
MAC Authentication
Enforcement Palicy

Authenticates
against SHL or

" other assigns
autgsgzsiﬂ;lﬂﬂ VLAN_Full_Access

No: Policy Manager assigns VLAN _Guest

Switch
Switch launches Aruba
Web Portal and passes Policy Manager processes
request attributes to [ using Aruba WabAuth
T olou e Policy Manager as Service
Webauth.
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